<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td><strong>EHS Environment,</strong></td>
<td></td>
</tr>
<tr>
<td>21.1</td>
<td>Basic Data and Hazardous Substance Management (New)</td>
<td>1</td>
</tr>
<tr>
<td>21.2</td>
<td>EH&amp;S Native Language Support (Enhanced)</td>
<td>1</td>
</tr>
<tr>
<td>21.3</td>
<td>Integration in PLM Extension 1.10 (New)</td>
<td>1</td>
</tr>
<tr>
<td>21.4</td>
<td>EHS-SAF Product Safety</td>
<td></td>
</tr>
<tr>
<td>21.4.1</td>
<td>IMG Structure Changes in Product Safety (Changed)</td>
<td>3</td>
</tr>
<tr>
<td>21.4.2</td>
<td>EHS-SAF-SPE Specification Management</td>
<td>3</td>
</tr>
<tr>
<td>21.4.2.1</td>
<td>Specification Management (Enhanced)</td>
<td>4</td>
</tr>
<tr>
<td>21.4.2.2</td>
<td>Assignment of Specifications and Materials (Enhanced)</td>
<td>4</td>
</tr>
<tr>
<td>21.4.3</td>
<td>EHS-SAF-RGE Report Generation</td>
<td>4</td>
</tr>
<tr>
<td>21.4.3.1</td>
<td>Report Generation (Enhanced)</td>
<td>4</td>
</tr>
<tr>
<td>21.4.3.2</td>
<td>WWI Installation (Enhanced)</td>
<td>4</td>
</tr>
<tr>
<td>21.4.3.3</td>
<td>WWI Functions (New)</td>
<td></td>
</tr>
<tr>
<td>21.4.4</td>
<td>EHS-SAF-INT Interfaces</td>
<td></td>
</tr>
<tr>
<td>21.4.4.1</td>
<td>Interface to SAP Unicode Systems (Changed)</td>
<td>8</td>
</tr>
<tr>
<td>21.4.4.2</td>
<td>ALE for EH&amp;S Reports (Enhanced)</td>
<td></td>
</tr>
<tr>
<td>21.4.4.3</td>
<td>Bill of Material Transfer (Enhanced)</td>
<td></td>
</tr>
<tr>
<td>21.4.4.4</td>
<td>Import of Vendor MSDS (New)</td>
<td></td>
</tr>
<tr>
<td>21.4.4.5</td>
<td>Data Import (Enhanced)</td>
<td></td>
</tr>
<tr>
<td>21.5</td>
<td>EHS-DGP Dangerous Goods Management</td>
<td>10</td>
</tr>
<tr>
<td>21.5.1</td>
<td>IMG Structure Changes in Dangerous Goods Management (Changed)</td>
<td>10</td>
</tr>
<tr>
<td>21.5.2</td>
<td>EHS-DGP-TP Template and One-Time Material Processing</td>
<td>11</td>
</tr>
<tr>
<td>21.5.2.1</td>
<td>Template and One-Time Material Processing (New)</td>
<td></td>
</tr>
<tr>
<td>21.6</td>
<td>EHS-HEA Occupational Health</td>
<td>11</td>
</tr>
<tr>
<td>21.6.1</td>
<td>Case History (Enhanced)</td>
<td></td>
</tr>
<tr>
<td>21.6.2</td>
<td>EHS-HEA-IIL Injury/Illness Log</td>
<td>11</td>
</tr>
<tr>
<td>21.6.2.1</td>
<td>Integration of Incident/Accident Log and Health Center Services (New)</td>
<td>11</td>
</tr>
<tr>
<td>21.6.2.2</td>
<td>Setting the Time Zone (New)</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>21.7</td>
<td>EHS-IHS Industrial Hygiene and Safety</td>
<td></td>
</tr>
<tr>
<td>21.7.1</td>
<td>Setting the Time Zone (New)</td>
<td></td>
</tr>
<tr>
<td>21.7.2</td>
<td>IMG Structure Changes in Industrial Hygiene and Safety (Changed)</td>
<td></td>
</tr>
<tr>
<td>21.7.3</td>
<td>EHS-IHS-WA Work Area Management</td>
<td></td>
</tr>
<tr>
<td>21.7.3.1</td>
<td>Work Area Hierarchy (Enhanced)</td>
<td></td>
</tr>
<tr>
<td>21.7.4</td>
<td>EHS-IHS-RSK Risk Assessment</td>
<td></td>
</tr>
<tr>
<td>21.7.4.1</td>
<td>Risk Assessment (Enhanced)</td>
<td></td>
</tr>
<tr>
<td>21.7.4.2</td>
<td>Analysis Method Summated Rating (New)</td>
<td></td>
</tr>
<tr>
<td>21.7.4.3</td>
<td>Customer-Specific Analysis Methods (Enhanced)</td>
<td></td>
</tr>
<tr>
<td>21.7.5</td>
<td>EHS-IHS-IA Incident/Accident Management</td>
<td></td>
</tr>
<tr>
<td>21.7.5.1</td>
<td>Incident/Accident Management (Enhanced)</td>
<td></td>
</tr>
<tr>
<td>21.7.5.2</td>
<td>Sending Accident Messages (New)</td>
<td></td>
</tr>
<tr>
<td>21.7.5.3</td>
<td>Menu Exits for Incident/Accident Management (New)</td>
<td></td>
</tr>
<tr>
<td>21.7.5.4</td>
<td>Integration of Incident/Accident Log and Health Center Services (New)</td>
<td></td>
</tr>
<tr>
<td>21.7.5.5</td>
<td>User-Defined Texts and Documents for Incident/Accident Log Entries</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
</tr>
</tbody>
</table>
21 EHS  Environment, Health and Safety

21.1 Basic Data and Hazardous Substance Management (New)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), new components and menu nodes are available in the SAP Environment, Health and Safety (SAP EH&S) component for the basic data and for hazardous substance management. These contain existing SAP EH&S functions such as New Functions for Importing Vendor MSDS.

Basic Data

Under the Basic Data node you can edit the data you need in a number of SAP EH&S components at one central point:

- You can match up master data.
- You can use the WWI monitor.
- You can display and edit the following data:
  - Generation variants
  - Report templates
  - Phrases
  - Phrase sets
  - Phrase groups
  - Sources
  - Regulatory lists
  - Data for QM inspection plan creation

Hazardous Substance Management

The safe handling of hazardous substances is becoming increasingly important. There are numerous regulations for the protection of your employees and other regulations you must observe when you place hazardous substances on the market or sell them. We have therefore grouped together all the SAP EH&S functions you require for managing hazardous substances under the Hazardous Substance Management node:

- You can edit hazardous substance data and other data on the substances present in your company in specification management, and search for and display it using the specification information system.
- You can edit work areas and patterns and link them with objects in Organizational Management.
- You can edit agents and risk assessments and determine amounts.
- You can edit, release, and ship EH&S reports (such as material safety data sheets, labels, and standard operating procedures), and search for and display them using the report information system.
You can import material safety data sheets and other documents from your vendors and manage them like other EH&S reports.

Note
Just as they were previously, these functions are also still available in the other SAP EH&S components, meaning no nodes have been removed from these components. The navigation instructions in the documentation still quote the previous paths, and the structure of the documentation is still based on the previous SAP EH&S components.

21.2 EH&S Native Language Support (Enhanced)

Use
As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110) you can also use the functions of EH&S Native Language Support (EH&S NLS) in SAP Systems with Unicode character sets. For this, you do not need to install either MDMP or a Blended Code Page. However, on SAP Systems without Unicode character sets you must install either MDMP or a Blended Code Page. For more information, see the documentation for Product Safety, EH&S Native Language Support section.

Effects on Customizing
You set up EH&S NLS in Customizing for Product Safety in the IMG activity Set Up EH&S Native Language Support.

21.3 Integration in PLM Extension 1.10 (New)

Use
As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), the SAP Environment, Health and Safety (SAP EH&S) component is part of PLM Extension 1.10 and is shipped with it. SAP EH&S Release 2.7B, Support Package 03 was integrated into PLM Extension 1.10 and was further developed there. This integration of SAP EH&S in the PLM Extension offers the following advantages:

- You no longer need to install SAP EH&S as an add-on software component. This simplifies installation and upgrade.
- You can install SAP EH&S at the same time as SAP R/3 Enterprise.
- You will receive corrections for SAP EH&S in the standard Support Packages and no longer in separate SAP EH&S Support Packages. Standard Support Packages and SAP EH&S Support Packages are no longer interdependent and therefore no longer need to be matched up.
- The documentation for SAP EH&S is now part of the documentation for SAP R/3 Enterprise. This means you now no longer need to install a separate documentation CD for SAP EH&S.

Note:
SAP EH&S remains a separate item on the SAP price list and still requires a separate license.
See also
SAP Note 122400 and 516465

21.4 EHS- SAF  Product Safety

21.4.1 IMG Structure Changes in Product Safety (Changed)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), the Implementation Guide (IMG) structure for Product Safety has been changed as follows:

- New IMG Activities:
  - Specification Management -> Specification Master section:
    EHS_MD_110_05_41  Set Up Specification Assignment in Material Master
  - Interfaces -> EH&S Application Link Enabling (ALE) -> ALE for EH&S Reports section:
    EHS_MD_150_40_02  Specify Additional Table and Parameter Filter

- Deleted IMG Activity:
  Report Generation -> Windows Wordprocessor Integration (WWI) -> WWI Installation
  section:
  EHS_SR_220_08_01  Set Up Microsoft Word

- Moved IMG Section:
  The IMG section EH&S-QM Interface was moved to the IMG section Interfaces.

21.4.2 EHS-SA F-SPE Specification Management

21.4.2.1 Specification Management (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), specification management has been enhanced to include the following functions:

- Excluding Indicator
  You set the Excluding indicator so that you can exclude a validity area from a higher-level larger validity area with the same rating when you define the usage.
  What is new is that usages for which the Excluding indicator is set for all validity areas are ignored by the system. This ensures that these validity areas cannot be interpreted by the system as subregions of a larger validity area because a larger validity area with the same rating does not exist.
  See also Excluding indicator.

- Nonempty Characteristics Function
The search function `<Specification category> with values assigned` has been enhanced. You can now search for specifications of a specific specification category for which certain characteristics have already been edited. To do this, select the relevant value assignment type in the search function dialog box. If you choose the new `Nonempty Characteristics` function in the dialog box, the characteristics of the value assignment are displayed for you to select and transfer as required. As the result of the search, the system displays all specifications of the current specification category that have any value set for the selected characteristics.

- **SP_NO_AUTH_CHK_REF_PROPS environment parameter: Deactivation of authorization check for referenced value assignments**
  The SP_NO_AUTH_CHK_REF_PROPS environment parameter was created for SAP EH&S Release 2.7B, Support Package 01.

- **SP_COMPCAT_CONFIDENTIAL environment parameter: Confidential component type**
  The SD_COMPCAT_CONFIDENTIAL environment parameter was created for SAP EH&S Release 2.7B, Support Package 01.

**Effects on Customizing**

To set up the environment parameters, edit the IMG activity `Specify Environment Parameters`.

### 21.4.2.2 Assignment of Specifications and Materials (Enhanced)

**Use**

A material, such as a raw material, can be assigned to a specification, such as a plant material, by means of an object link. This assignment could previously only be made from Product Safety. As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can also make the assignment in the material master.

**Effects on Customizing**

The required settings must be made in Customizing for the Material Master. For more information, see Customizing for Product Safety under `Set Up Specification Assignment in Material Master`.

### 21.4.3 EHS-SAF-RGE Report Generation

**21.4.3.1 Report Generation (Enhanced)**

**Use**

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), report generation has been enhanced to include the following functions:

- **Change Mark Indicator**
  In the report generation variant header, the previously two-value indicator `Generate change marks` has been replaced by the new three-value `Change mark` indicator.
  For more information:
- On the new indicator, see the documentation on the data element Change mark
- On the conversion program RC1XCHGFLG, see under Effects on System Administration (see below)

**Assigned Validity Areas Are Dangerous Goods Regulations (DGReg.) Indicator**

From SAP EH&S Release 2.7B, Support Package 02 you can restrict the following on EH&S reports:
- The output of the transport classification to specific dangerous goods regulations predefined in the generation variant
- The output of dangerous goods data for the assigned UN-listed substances to the dangerous goods data for the predefined dangerous goods regulations

For more information, see the:
- Documentation for the new DGReg. field (Assigned Validity Areas Are Dangerous Goods Regulations) in the IMG activity Specify Validity Area Categories
- Enhancement of the repeating group of type G

**Filter for the Repeating Group of Type G**

From SAP EH&S Release 2.7B, Support Package 02 there is a new variant. In total you can use the following three variants in the report template:
- Validity area and language restriction
  Example: <11BRG000(G,A:REG_EU,L:DE;*)>
- Validity area category and language restriction
  Example: <11BRG000(G,T:REGION,L:DE;*)>
- Validity area category restriction
  Example: <11BRG000(G,T:REGION,L:*,*;*)>

**Effects on System Administration**

**Conversion Program RC1XCHGFLG for Change Mark Indicator**

To convert the Generate change marks indicator (data element ESEMCHGFLG) to the new Change mark indicator (data element ESEMCHCCK), execute the conversion program RC1XCHGFLG.

For more information, see the documentation for the RC1XCHGFLG program.

**Effects on Customizing**

**Assigned Validity Areas Are Dangerous Goods Regulations (DGReg.)**

To edit the Assigned Validity Areas Are Dangerous Goods Regulations (DGReg.) indicator you must edit the following IMG activity:

Specify Validity Area Categories.
21.4.3.2 WWI Installation (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), the installation of the Windows Wordprocessor Integration (WWI) program has been enhanced.

As of this Release, WWI also supports Windows XP.

Enhancements to the Generation Server

- During installation you must enter a license key. For test purposes or if you have not yet received the license key, you can operate the WWI generation server once for 10 days without a license key. For more information, see SAP Note 513330.

- The installation routine has been extended. For more information, see the IMG activity Install Generation Server on Generation PC.
  - You have the option of setting up printers for different output formats. For more information, see point 4 in the IMG activity Install Generation Server on Generation PC.
  - You have the option of setting up user exits for different output formats. For more information, see point 5 in the IMG activity Install Generation Server on Generation PC.

Enhancements for Layouting

- Editing report templates was previously possible only to a certain extent on Windows terminal servers (such as Citrix) because user-independent registry entries were used. Only one user could edit a report template at any one time. This restriction no longer exists.

- Existing changes to Word settings made by WWI macros are reset to their old status after you have finished editing a report template. This means you can then easily edit Word documents and display WWI reports.

The following Word settings are affected:
- Tools -> Options -> View -> Nonprinting characters (Microsoft Word 97) / Formatting marks (Microsoft Word 2000/XP) -> All
- Tools -> Options -> View -> Nonprinting characters (Microsoft Word 97) / Formatting marks (Microsoft Word 2000/XP) -> Hidden text
- Tools -> Options -> View -> Show -> Field codes

In reverse, when you start editing a report template, the same settings are reset again to the settings last used when editing a report template.

- When you change the menu language, the WWI.DOT file is no longer saved as it previously was. You can now also change the settings offline by opening the WWI.DOT in Word and choosing WWI -> Basic Settings.

- It is no longer necessary for the Windows environment variable Path to reference the WWI directory.

- Extending the Word template paths:
  For Microsoft Word 97 it is no longer necessary to localize the files WWI.DOT and
WWIDISPL.DOT in one of the Word paths for user templates or workgroup templates. For Microsoft Word 2000 and XP, this is still necessary if the macro security level is not to be set to low. For more information, see:

- The IMG activity Set Up WWI
- The IMG activity Install Generation Server on Generation PC under point 2

**Interface to SAP Unicode Systems**

WWI is still an ASCII-based program, but it also supports SAP Unicode systems. At the interface, data is converted from Unicode into the appropriate ASCII code page (single byte or double byte) and vice versa.

See also the Release Note *EH&S Native Language Support (Enhanced).*

The mechanism for converting the fonts for each code page remains the same in the WWI program ([Fonts] section in WWLINI).

**Effects on Customizing**

To set up the described functions, you must edit the following IMG activities:

- WWI installation, Word template paths
  - Install Generation Server on Generation PC
  - Set Up WWI
- Switching the menu language:
  - Set Up WWI Menu Language

**21.4.3.3 WWI Functions (New)**

**Use**

As of *SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110)*, the following new functions have been developed for the *Windows Wordprocessor Integration* (WWI) program:

- **Mandatory Report Symbols**
  
  Certain values must exist on a report for it to be considered complete from a technical point of view. You now have the following options for setting up mandatory report symbols that must be filled:

  - In Customizing for Product Safety:
    You can define a symbol in Customizing as a general mandatory symbol by assigning the symbol a message type in the IMG activity *Check and Specify Report Symbols.* If no value exists for the symbol during generation, an appropriate message appears on the report and in the report log. For more information, see the documentation for the data element *Message.*

  - On the report template:
    When inserting a symbol in the report template, you can set the Value Mandatory indicator. When the report is generated, the system then checks whether the value exists for the symbol at the relevant position. If the value does not exist, a message informing you of this appears on the report and in the report log as you defined in Customizing.

  Note:
Currently only the message type W (warning) is supported.

- **REPORT_GENERATION_PROTOCOL Environment Parameter: Report generation log is written**
  The new environment parameter REPORT_GENERATION_PROTOCOL was created for *SAP EH&S Release 2.7B, Support Package 01*. You can use it to activate logging of report generation.

- **Overflow Warning for Automatic Character Sizing**
  As of *SAP EH&S Release 2.7B, Support Package 01*, warnings can be logged when report bodies are being generated if the text still does not fit in its text box when it has reached its minimum size after automatic character sizing.
  
  **Note:**
  The following entries in the configuration file WWI.INI for the WWI generation server activate the function:
  ```ini
  [global]
  DyntextWarnings=1
  DyntextOnRawReport=1
  DyntextWarnings activates the logging of warnings during automatic character sizing.
  DyntextOnRawReport causes automatic character sizing to be run during report body generation for all text boxes that are already completely merged. Without this switch, automatic character sizing is always run first with the final report.
  ```

**Effects on Customizing**

To set up the described functions, you must edit the following IMG activities:

- Mandatory report symbols:
  *Check and Specify Report Symbols*

- REPORT_GENERATION_PROTOCOL environment parameter:
  *Specify Environment Parameters*

### 21.4.4 EHS-SAF-INT Interfaces

#### 21.4.4.1 Interface to SAP Unicode Systems (Changed)

**Use**

- As of *SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110)*, EH&S Expert supports Windows XP.

- WWI and EH&S Expert are still ASCII-based programs, but they also support SAP Unicode systems. At the interface, data is converted from Unicode into the appropriate ASCII code page (single byte or double byte) and vice versa.
21.4.4.2 ALE for EH&S Reports (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), Application Link Enabling (ALE) has been enhanced to include the customer exit C14A0007. This SAP enhancement allows you to set up tables to transfer additional data and parameter filters.

Note:

The enhancement was already available from SAP EH&S Release 2.7B, Support Package 01.

Effects on Customizing

To develop the customer exit C14A0007, edit the IMG activity Specify Additional Table and Parameter Filter.

21.4.4.3 Bill of Material Transfer (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), the customer exit C1L30001 for the IMG activity Develop Enhancement for Calculating Composition has been enhanced to include the output parameter E_COMPREL. For more information, see the documentation for the customer exit C1L30001.

Note:

The enhancement was already available from SAP EH&S Release 2.7B, Support Package 02.

Effects on Customizing

To develop the customer exit C1L30001, edit the IMG activity Develop Enhancement for Calculating Composition.

21.4.4.4 Import of Vendor MSDS (New)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), this function is available to you in the SAP Environment, Health and Safety (SAP EH&S) component to import vendor material safety data sheets (MSDS).

The new function extends the existing document import functions available to you for importing mass data. For sporadic imports, you can use the new function in which you enter data directly instead of using the key file that would otherwise be necessary.

To call the function, in the SAP Easy Access screen choose Logistics -> Environment, Health and Safety -> Hazardous Substance Management -> Reports -> Import Vendor MSDS.
21.4.4.5 Data Import (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), data import has been enhanced to include the following functions:

- **Character Standard Field**
  You must specify the character standard so that the system can read the import file correctly.

- **IMPEXP_FLG_DELETE_PHYSICAL environment parameter: Specification import deletes physically**
  The IMPEXP_FLG_DELETE_PHYSICAL environment parameter was created for SAP EH&S Release 2.7B, Support Package 02.

Effects on Customizing

To set up the environment parameter IMPEXP_FLG_DELETE_PHYSICAL, edit the IMG activity Specify Environment Parameters.

21.5 EHS-DGP Dangerous Goods Management

21.5.1 IMG Structure Changes in Dangerous Goods Management (Changed)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), the Implementation Guide (IMG) structure for Dangerous Goods Management has been changed as follows:

New IMG Activities

The IMG structure has been extended to include the node Template and One-Time Material Processing. The following IMG activities are located below this node:

- Settings for Template and One-Time Material Processing
- Specify Fields for Template and One-Time Material Processing
- Specify Determination Routines for Template and One-Time Materials
- Specify Determination Routine for Sales and Shipping Documents
- Specify Determination Routine for Shipment Documents
- Specify Validity for Template and One-Time Material Processing
- Specify Permitted Combinations for Sales Documents
- Specify Permitted Combinations for Shipment Documents
- Specify Permitted Combinations for Shipment Documents
- Customer Enhancement for Rescheduling in Shipment Document
21.5.2 EHS-DGP-TP Template and One-Time Material Processing

21.5.2.1 Template and One-Time Material Processing (New)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), template and one-time material processing has been made available for Dangerous Goods Management.

Template and one-time material processing makes it easier for you to handle logistics processes including dangerous goods checks and dangerous goods documents for substances whose description, properties, and dangerous goods data vary. The time and effort involved in dangerous goods classification is reduced considerably, in particular for substances you wish to ship only once.

21.6 EHS-HEA Occupational Health

21.6.1 Case History (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL_110), you can choose which screen you want to use to enter a case history.

Previously you could only enter details on a patient's own case history, family case history, or occupational case history on the case history screen. If you decide to use the new screen, you can also enter other case history types, such as external case history.

Effects on System Administration

You can transfer existing data by executing the report program REHS_DATA_TRANS_TO_ANAM_NEW. For more information, see the documentation for the report program.

Effects on Customizing

If you decide to use the new case history screen, you should set the environment parameter OHS_NEW_ANAM_SCREEN in Customizing for Occupational Health in the IMG activity Specify Environment Parameters.

21.6.2 EHS-HEA-IIL Injury/Illness Log

21.6.2.1 Integration of Incident/Accident Log and Health Center Services (New)
Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can navigate from the Incident/Accident Log: Edit Person-Specific Data screen to the health center services in SAP EH&S Occupational Health. The system first checks whether you have the necessary authorization. If you do, the overview of health center services that exist for the person affected appears. If a corresponding health center service exists, you can assign the incident/accident log entry to it.

The health center service is used in Occupational Health to enter and manage unplanned medical treatment and services. If an incident/accident log entry was assigned to a health center service, it can be called directly from the health center service (if the user has display authorization for incident/accident log entries).

Effects on Customizing

You require at least display authorization for health center services. You set up this authorization using the authorization object C_EHSH_SRV (Medical Service).

Further notes

In line with the integration of the incident/accident log and health center services, the injury/illness log has also been integrated with the health center services as of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110).

21.6.2.2 Setting the Time Zone (New)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can specify the time zone when you enter times and dates in Industrial Hygiene and Safety and in the injury/illness log in Occupational Health. If your company works in a number of time zones, you can then specify the valid time zone in each case.

Effects on Existing Data

If you want to activate the function later, you must execute the REHS_XPRA_FILL_TZONE program. It adds the time zone in existing data records.

Effects on Customizing

The function is not active in the standard system. To activate it, you must make the required settings for the environment parameter IHS_USE_TIMEZONE in Customizing for Industrial Hygiene and Safety in the IMG activity Specify Environment Parameters.

21.7 EHS-IHS Industrial Hygiene and Safety

21.7.1 Setting the Time Zone (New)
Use

As of *SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110)*, you can specify the time zone when you enter times and dates in *Industrial Hygiene and Safety* and in the *injury/illness log* in *Occupational Health*. If your company works in a number of time zones, you can then specify the valid time zone in each case.

**Effects on Existing Data**

If you want to activate the function later, you must execute the `REHS_XPRA_FILL_TZONE` program. It adds the time zone in existing data records.

**Effects on Customizing**

The function is not active in the standard system. To activate it, you must make the required settings for the environment parameter `IHS_USE_TIMEZONE` in Customizing for *Industrial Hygiene and Safety* in the IMG activity *Specify Environment Parameters*. 

21.7.2 IMG Structure Changes in Industrial Hygiene and Safety (Changed)

**Use**

As of *SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110)*, the Implementation Guide (IMG) structure for *Industrial Hygiene and Safety* has been changed as follows:

**Deleted:**

The *Exposure Management* structure node has been deleted.

**New IMG Activities:**

The following new IMG activities were added in the *Risk Assessment* structure node:

- Specify Reasons for Risk Assessments
- Set Up Risk Matrix
- Set Up Analysis Method Questionnaire

Under *Incident/Accident Management*, the new structure node *Menu Exits for Incident/Accident Management* was added with the following menu exits:

- Develop Enhancement 1 for Incident/Accident Log Menu
- Develop Enhancement 2 for Incident/Accident Log Menu
- Develop Enhancement 1 for Data on Person Involved Menu
- Develop Enhancement 2 for Data on Person Involved Menu

**Enhanced IMG Activities:**

The following IMG activities under *Risk Assessment* were extended to include new functions:

- Specify Measurement Items
- Specify Exposure Ratings
Restructured or Renamed IMG Activities:

- The activities Specify Exposure Ratings and Specify Agent Types that were located under the deleted structure node Exposure Management have been moved to the Risk Assessment node.
- The activity Set Up Questionnaire has been moved from the Integration structure node to the Basic Settings node.
- The activity Specify User-Defined Text Types has been moved from the Work Area Management structure node to the Basic Settings node.
- Under Basic Settings, the activities that already existed in earlier Releases Create Phrase Sets and Assign Phrase Sets to Fields have been grouped under the new subnode Phrases.

New Organizational Activities (Documentation):

- Under Basic Settings -> Symbols, the following new organizational activities have been added:
  - Create Symbols for Characteristics
  - Create Symbols for Table Fields
- Under Integration, the new documentation Integration in Occupational Health has been added.

21.7.3 EHS-IHS-WA Work Area Management

21.7.3.1 Work Area Hierarchy (Enhanced)

Use

The work area hierarchy function has enhanced navigation options as of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110). For each selected work area, you can now navigate directly from the hierarchy tree to the dependent data, and change or display the data. Previously you could only display the header data.

You can therefore use the work area hierarchy as an additional central starting point for managing data, along with the hit list.

21.7.4 EHS-IHS-RSK Risk Assessment

21.7.4.1 Risk Assessment (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can use the following enhancements in risk assessment:

- Reason for Risk Assessment
  Using the new Reason field you can categorize risk assessments according to the reason they were performed. You can also use the reason as a search criterion for drilldown searches.
Risk Evaluation
For each agent you examine, you can enter the severity and the probability of the risk. Using a matrix that you store in Customizing, the system then determines the rating. The rating is not displayed directly, but flows into the calculation of the main rating.

Periodic Risk Assessment
You can use an additional input field to specify when the next risk assessment is to be performed. This means, for example, that you can search specifically for risk assessments whose planned date has already been exceeded.

Analysis Method Questionnaire: Calculation of Rating
The system can calculate the rating based on the answers given in the questionnaire. Previously the rating could only be assigned manually.

Effects on Customizing
To be able to use the enhancements, you must edit the following IMG activities in Customizing for Industrial Hygiene and Safety:
- Specify Reasons for Risk Assessments
- Set Up Risk Matrix
- Set Up Analysis Method Questionnaire

See also
The following Release Notes also relate to risk assessment:
- Analysis Method Summated Rating (New)
- Customer-Specific Analysis Methods (Enhanced)

21.7.4.2 Analysis Method Summated Rating (New)

Use
As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can assess the hazard potential of mixtures using the analysis method summated rating. You can assess both compositions and situations where agents occur together in combination.

Effects on Customizing
To use the analysis method, you must assign it to the agent types for which it is relevant in Customizing for Industrial Hygiene and Safety in the IMG activity Assign Analysis Methods to Agent Types. You must also check whether the necessary settings for reading reference values from the specification database exist under Specify Measurement Items.

See also
For more information about summated ratings, see the application help for Industrial Hygiene and Safety under Analysis of Mixtures.
21.7.4.3 Customer-Specific Analysis Methods (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can create up to ten customer-specific analysis methods. In earlier Releases you could only create a maximum of four new analysis methods.

Effects on Customizing

In the standard system there are samples available that you can use as copy templates for creating new analysis methods. You will find the procedure described in Customizing for Industrial Hygiene and Safety under Create Analysis Methods.

To be able to address the customer-specific analysis methods in the application, you must make the necessary system settings for them in Customizing for Industrial Hygiene and Safety under Assign Analysis Methods to Agent Types.

21.7.5 EHS-IHS-IA Incident/Accident Management

21.7.5.1 Incident/Accident Management (Enhanced)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), the following enhancements are available in incident/accident management:

- Call of report information system from incident/accident log header data screen
  In addition to the existing link in the person-specific data screen, you can now call the report information system from the header data of an incident/accident log entry. The link is based on an independent application object for the incident/accident log entry so that it is now possible to create reports on the person affected and on general accident events independently of each other.

- User exit for dialog to display personal data
  So that you can adapt the dialog for displaying personal data for the persons involved to suit your customer-specific requirements, it has been implemented as a user exit. You can now, for example, display additional personal data.

- User exit for customer-specific check routines in the API
  This user exit allows you to set up checks for creating and updating the incident/accident log header data in the API (Application Programming Interface). This allows you, for example, to implement a required entry field check for the work area in the incident/accident log entry or a duplicate check for the event date and the plant.

Effects on Customizing

To use these enhancements, you must edit the IMG activity Manage User Exits in Customizing for Industrial Hygiene and Safety for the user exit categories IHS_SRPOP (Personal data dialog) and IHS_IALCHK (Checks in API).
See also

The following Release Notes also relate to incident/accident management:

- Integration of Incident/Accident Log and Health Center Services (New)
- Menu Exits for Incident/Accident Management (New)
- Sending Accident Messages (New)
- User-Defined Texts and Documents for Incident/Accident Log Entries (New)

21.7.5.2 Sending Accident Messages (New)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can distribute information about an incident or accident in the form of a message (e-mail). An attachment that contains the relevant information on the event is automatically included with the message.

Effects on Customizing

The function call and the content of the attachment are in the form of user exits. This means you can adapt them to fulfill your requirements. For more information, see Customizing for Industrial Hygiene and Safety under Manage User Exits.

21.7.5.3 Menu Exits for Incident/Accident Management (New)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can use menu exits to call other SAP applications or customer applications from incident/accident management. For this purpose, two menu exits for the header data of the incident/accident log entry and two menu exits for the detail dialog box for person-specific data have been implemented.

Effects on Customizing

If you want to use the menu exits, you must edit the following IMG activities in Customizing for Industrial Hygiene and Safety:

- Develop Enhancement 1 for Incident/Accident Log Menu
- Develop Enhancement 2 for Incident/Accident Log Menu
- Develop Enhancement 1 for Data on Person Involved Menu
- Develop Enhancement 2 for Data on Person Involved Menu
21.7.5.4 Integration of Incident/Accident Log and Health Center Services (New)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110), you can navigate from the Incident/Accident Log: Edit Person-Specific Data screen to the health center services in SAP EH&S Occupational Health. The system first checks whether you have the necessary authorization. If you do, the overview of health center services that exist for the person affected appears. If a corresponding health center service exists, you can assign the incident/accident log entry to it.

The health center service is used in Occupational Health to enter and manage unplanned medical treatment and services. If an incident/accident log entry was assigned to a health center service, it can be called directly from the health center service (if the user has display authorization for incident/accident log entries).

Effects on Customizing

You require at least display authorization for health center services. You set up this authorization using the authorization object C_EHS_SH_SRV (Medical Service).

Further notes

In line with the integration of the incident/accident log and health center services, the injury/illness log has also been integrated with the health center services as of SAP R/3 Enterprise PLM Extension 1.10 (EA_APPL 110).

21.7.5.5 User-Defined Texts and Documents for Incident/Accident Log Entries (New)

Use

As of SAP R/3 Enterprise PLM Extension 1.10 (EA-APPL 110), you can also use the user-defined texts and documents function used throughout SAP Environment, Health and Safety for entries in the incident/accident log. In earlier Releases, the function was available in Industrial Hygiene and Safety only for work areas.

With the function you can enter additional comments of any chosen length (user-defined texts) about an accident event using the SAPscript editor. In addition, you can import documents that were not created in the SAP System, assign them to an incident/accident log entry, and display them. One such example is sketches of accidents. The document management system (DMS) is used to import and manage the documents.

You can control the use of the function using authorizations.

Effects on Customizing

To set up the function, you must edit the IMG activity Specify User-Defined Text Types in Customizing for Industrial Hygiene and Safety.

If you want to use the authorization check, you must make the required settings for the authorization object C_EHS_SD_DOC and activate the check in another step. You must also extend the authorization
profiles for the users accordingly. For more information on assigning authorizations, see Customizing for Industrial Hygiene and Safety, Specify Authorizations.

You should also make sure that the document types you require were created from the DMS in Customizing for Document Management under Define Document Types.